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Introduction 
This document details the release of software PSS0002-34: version 5.61 of the software 
for the Mastersizer 2000 laser diffraction system. It covers software issues fixed and new 
features introduced. This information is required to perform a risk analysis to determine if 
the software should be installed. In this risk analysis the benefits of the new features 
provided and resolved software issues must be weighed against the risk of new issues 
that may be introduced to vital areas of the software or possible changes to the results of 
future analysis. Installation instructions are provided. 

Installation 
It is assumed that you have authority to install or update software within your facility. It is 
also assumed that you have Administrator rights for the system upon which the software 
is installed, as this is a requirement of the installation process. If you do not have this 
authority please consult with your I.T. support department before proceeding. 

Recommended System Requirements 

The recommended computer system requirements for running this software are 
highlighted in table 1 below. The software can be operated using Windows 10 (Pro and 
Enterprise), Windows 8.1 (Pro and Enterprise), Windows 8 (Pro and Enterprise), Windows 
7 32 bit (Pro, Enterprise and Ultimate) and Windows 7 64 bit (Pro, Enterprise and 
Ultimate). However, it has been fully tested using Windows 7 Ultimate (32 bit). Windows 
7 Ultimate (32 bit) is therefore the preferred operating system.  

Supported Languages 

Mastersizer 2000 v5.61 software currently supports operation in the following languages: 

• English 

• Japanese 

• Chinese (simplified) 

French and German language options are only available for v5.12 of the Mastersizer 
2000 software. 
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Table 1: Recommended system requirements for the Mastersizer 3000 software. 

Feature Specification

Memory 1024 MB 

Hard Disk Storage 80GB 

Additional Storage Media CD-ROM or DVD +/-RW drive 

Display Resolution 1024 x 768 

Connectivity 1 RS232 COM Port 

Operating System Windows XP 

Windows 7 (32 bit - Pro, Enterprise and Ultimate) 

Windows 7 (64 bit - Pro, Enterprise and Ultimate)  

Windows 8.1 (64 bit - Pro and Enterprise) 

Windows 10 (64 bit - Pro and Enterprise) 

Installation Instructions 
The Mastersizer 2000 software is provided on one auto-loading CD-ROM. Inserting the CD-ROM into a system configured to auto- 
run a CD will run the installation program automatically. If your system does not support this feature run the \setupMS2K.exe 
program from the root directory of your CD drive. 

Note: In order to comply with the security requirements for the Windows operating systems, the directory structure used by the 
Mastersizer 2000 software has been changed compared to earlier versions. Please refer to the Known Issues section of this 
document in order to understand these changes prior to installing this software. 

 

Note: Some of the changes made to the control of the Mastersizer 2000 accessories require the accessory firmware to be 
updated when upgrading previous versions of the Mastersizer 2000 software. Please contact Malvern Instruments for 
information regarding how to upgrade the accessory firmware. 

Uninstall Procedure 
The software can be uninstalled using the standard Add/Remove Programs feature in the Windows Control Panel. 

Software Categorization   

GAMP 5 
The GAMP 5 guide provides guidance to pharmaceutical companies wishing to understand whether the computerized systems and 
software they used are fit for purpose and meet current regulatory requirements. As part of this, the GAMP committee has defined 
a series of software categories which are designed to help users in assessing the risk and validation requirements associated with 
using a specific software package. 

In its standard mode of operation, the Mastersizer 2000 software provides users with a series of standard interfaces and functions 
that enable the software to be configured to meet specific user business requirements. These interfaces include the ability to define 
Standard Operating Procedures (SOPs) for sample measurement, create report definitions using pre-defined functions and develop 
data export templates using pre-defined parameters. If users apply these functions then the software can be considered to be a 
Category 4 product. 

In addition to the standard functions, the Mastersizer 2000 software provides users with the ability to modify the results reported 
by the system to fit their application requirements. This is achieved through the use of the custom calculation reporting functions. 
These functions are not widely applied within regulated environments. However, if they are used to meet business requirements 
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then the macros included within the custom calculations should be validated according to GAMP Category 5 requirements. Users 
are therefore encouraged to specifically validate any custom calculations applied within their reports and ensure these are 
documented. Where possible, we would encourage the use of the standard result reporting features, as this minimizes the risk of 
errors in the reported size distribution statistics. 

USP<1058> 
USP<1058> provides pharmaceutical users with guidance as to how the qualification of analytical systems should be carried out. As 
part of this guidance, the USP define a series of instrument categories. These instrument categories different from those described 
in GAMP 5, although the principles applied as part of the classification of a system are similar. 

The Mastersizer 2000 is a computerized analytical system where the software provides users with the functions required to meet 
specific analytical application requirements. As such, it is a Group C instrument. Users are therefore recommended to define their 
requirements for the operation of the system and then compare these requirements to the claimed capabilities of the software and 
hardware. This should include an assessment of whether the new features and bug fixes included in a specific version of the 
Mastersizer 2000 software are necessary to meet business requirements.  

 

New Features List 

21 CFR Part 11 Support 
Mastersizer 2000 v5.xx software includes full support for customers who require the software to run within a 21 CFR Part 
11 compliant environment. This includes new features relating to software access control, measurement auditing and the 
setting up of SOPs. These features are enabled by use of a software feature key which is specific to each instrument. Please 
contact your local Malvern Representative if you wish to obtain a feature key in order to enable the software’s 21 CFR Part 
11 features on your system. 

Full details of the 21 CFR Part 11 features available within the Mastersizer 2000 software can be found in the following 
documents included on the Mastersizer 2000 software CD-ROM: 

• 21 CFR Part 11 User Guide (MRK1065-xx) – provides a full description of the software features associated with 21CFR 
Part 11, including the software’s security system. 

• 21 CFR Part 11 Compliance Guide for the Mastersizer version 5.12 or later (MRK537-xx) – background information for 
users relating the functionality provided within the Mastersizer 2000 software to each of the requirements mentioned 
with 21CFR Part 11. 

 

Fixed issues list 
Mastersizer 2000 v5.61 includes the bug fixes referenced in the table below. 

Reference(s) Issue 

9070 Appearance of application needs to be updated to show new Malvern logo 

9219 User icon does not display for locked-out user within the security system. 

9307, 9308 Unknown user sometimes appears in the audit trail. 

9318 21CFR11 security: Most Recently Used list is not correct 

9360 Reason for change is sometimes not added to the audit trail when editing a record 

9769 21 CFR 11 issue for Japanese Software: In exported audit trail, the software version and user name appear blank 
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9788 21 CFR Part 11 bug relating to security server. 

9977 Software version reported incorrectly in the Windows Control Panel 

9987 
21 CFR Part II: On Windows 7, after the Windows permission is set to deny deleting files within a folder, Windows 
also denies permission to save a new file 

 

Known Issues 

Autosampler 2000 Additive and Dispersant Syringe Operation 
It is possible for the Autosampler 2000 additive and dispersant syringe pumps to stall during operation, causing the Autosampler 
measurement schedule to halt. In order to overcome this, the firmware for the Autosampler 2000 has been updated to ensure that 
the syringes slowly accelerate to the required pump rate during operation. This has improved the robustness of operation of the 
Autosampler 2000 system. 

Loss of security settings 
It has been discovered that, when upgrading to Mastersizer 2000 v5.61 software from versions earlier than v5.54, it is possible for 
information relating to the security system set-up to be lost, including the user names and passwords for any users set up on the 
system. Users who have configured the security system to control access to the Mastersizer 2000 software for different user groups 
are advised to read Malvern Instruments’ Technical Bulletin 1296, which provides a procedure for ensuring that the software can 
be upgraded without loss of the security system settings. This technical bulletin is included in the Documents section of the 
software CD-ROM. If you are in doubt about this procedure, please contact your local Malvern Representative for advice. 

New Directory Structure 
Since the launch of Windows 2000, the Windows operating system has been set up to discourage the storage of data files into the 
Program Files group of folders. In order to avoid the security access problems associated with using the Program Files folders, this 
version of software has been set up to store data in the shared folders. The root Mastersizer 2000 data directory will therefore be 
set to: 

• For Windows XP: C:\ Documents and Settings\All Users\Shared Documents\Malvern Instruments\Mastersizer 2000 

• For Windows 7-10: C:\Users\Public\Public Documents\Malvern Instruments\Mastersizer 2000 

When updating an earlier software version, the software installation procedure will automatically move all of the user data from 
the previous root directory (C:\Program Files\Malvern Instruments\Mastersizer 2000) into the new directory structure.  

 

Note: It is recommended that users back-up their data prior to carrying out the installation process and should note both the 
old and new locations of the Mastersizer 2000 data files. 

Changes to SOP version control 
In previous software versions a mismatch could be observed between the SOP version number reported from the Compare SOPs 
dialogue and the version number reported on the records view. This inconsistency has been addressed in version 5.30 and above of 
the Mastersizer 2000 software. However, the fix applied may cause the reported version number to change on result printouts. The 
observed behavior will be: 

• If the SOP version shown in the Compare SOPs dialogue was the same as the SOP version number reported on the records 
view, then no change will be observed. 

• If the SOP version shown in the Compare SOPs dialogue was lower than the SOP version number reported on the records 
view, then the SOP version will be taken to be the higher value. 

As such, it is possible that some users will notice an increase in the SOP version number reported in the software. 
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Scirocco Venturi Identification 
In version 5.30 and above, the ability to detect the type of venturi fitted to the Scirocco dry powder feeder has been provided. This 
requires the setting of one of the accessory identification switches (the A/B switch). As such, this feature will only work correctly for 
new Scirocco dry powder feeder units where the identification switch has been set according to the venturi type. For older Scirocco 
systems users should select the “Original Configuration” option in the SOP settings associated with the Scirocco in order to disable 
the auto-sensing feature. If users want to enable the ability to sense the venturi type for older Scirocco systems, then please 
contact your local Malvern representative. 

Upper Size Limits and Dv100 reporting 
 

Note: The use of the Dv100 as a control parameter is not advised, as this parameter is subject to large variations based on small 
changes in the dispersion and sampling regime. Malvern recommends that users use percentiles such as the Dv90 or Dv95 to 
provide control of the upper end of the size distribution. 

 

In previous software versions, some variability in the reported upper size limit for Mastersizer 2000 results was observed. This was 
caused by an incorrect tendency for the analysis to report an extremely small volume percentage of material (>0.0001%) at the 
limits of the analysis. This, coupled with the calculation method used for percentiles, caused the reported Dv100 to change 
considerably between measurements. 

In version 5.30 or above the analysis error associated with the reporting of small volumes of material at the analysis limits has been 
fixed and a new method for calculating the Dv100 has been implemented. These changes may affect the Dv100 reported by the 
analysis, especially for those samples where the Dv100 value was always reported to be 2000μm. Testing has shown, however, 
that the shift in the reported values for percentiles below the Dv99.5 is negligible. 

File sizes 
In order to increase program performance, measurement records are kept in memory. For customers with a large number of 
measurements in a single file, this will affect the system performance by consuming large amounts of available memory. The best 
practice is to keep the number of measurement records in a single file to less than 1000, by creating new files on a regular basis. 
File access problems will be experienced within the Mastersizer 2000 application if the file size increases to greater than 2GB. 

Installing an earlier version after un-installing v3.x. or above 
To replace the Mastersizer 2000 application with another version, it is necessary to first uninstall the software using the command 
provided. When moving from version 3.x to version 2.00 or below, you must replace the Mastersizer 2000.ini file for the operation 
to succeed. Once the later software has been uninstalled, rename the Mastersizer 2000.ini file Mastersizer 2000.in3. Then install 
the earlier version. If this is not done, the old application will not run correctly. 

New security system 
The new security system introduced in v5.00 and higher is incompatible with the pre-existing ‘Secure Layered Access’ system. If 
v5.00 or higher is installed on a system with v4.00 or lower, the security settings will have to be reconfigured to add users and 
groups. 

Autosampler - flashing accessory icons 
The new version of the instrument firmware (FIDACS v1.03 or greater) must be downloaded to any instrument where an 
autosampler is to be used. A full description of how to do this is included in the contents.txt file, stored in the root directory of the 
installation CD. 

Localized number formats 
The software does not function correctly if the number format set in the localization settings of the system has the comma 
character either as the decimal marker of as the separator for thousands. The remedy is to modify the number format to exclude 
this character. This can be done in the Regional Options of Control Panel. 
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Lactose Refractive Index 
The Lactose refractive index listed in the Mastersizer 2000 particle property database (1.347) is incorrect. The correct value for 
Lactose should be between 1.52 and 1.54. The entry has not been changed, as this could affect existing methods. If users wish to 
use the correct value, they are requested to set up a new entry in the software’s particle properties database. 

Edit-Copy Parameter 
In Mastersizer 2000 version 5.60, a bug fix has been applied to ensure the Edit->Copy function associated with report views does 
not cause the software to crash. Users should note that this menu option will only copy the first parameter added to the report 
during report creation. If the copying of multiple parameters is required, users are advised to set up an export template containing 
the desired parameter set. The File->Export Data command, available when the Records view is active, can then be used to export 
the parameters to the Windows clipboard. Alternately, if the export template is set as the default template, the Edit-Copy menu 
option can be used to transfer the parameters to the clipboard. 

Accessing Measurement Files via Windows Explorer 
In the past, it has been possible to open a Mastersizer 2000 measurement file by double-clicking on the file from within Windows 
Explorer. This caused the Mastersizer 2000 software to start with the selected file opened. The operating system mechanism 
required to enable this to occur (Dynamic data exchange) has been removed from Windows VISTA. For this reason, this mechanism 
for opening files has been disabled in v5.60 of the software. Double clicking on a Mastersizer 2000 measurement file will cause the 
software to start, but users will have to browse for the file using the File->Open menu option within the software. 

If you are using Windows XP, a mechanism does exist for re-enabling the ability to open files from within Windows Explorer. Please 
contact your Malvern Representative for a technical note describing how this can be done. 

Overlay cumulative color problem 
The frequency and undersize/oversize plot should be the same color so you can see which plots belong to which record. The 4th 
undersize/oversize plot has different colors for these curves making it harder to determine which plot belongs to which curve. 

SOP Parameter Reporting 
For computer systems operating in time zones which are set at half-hour increments from GMT (e.g. Mumbai, India at GMT 
+5:30hrs, Adelaide Australia at GMT +9:30hrs), a bug has been discovered relating to the way some time-based parameters are 
displayed within the SOP editor dialogues. For parameters such as the Pre-measurement delay and Obscuration Filter Time-out, the 
software appears to add 30 minutes to any user-specified time. So, if 45 seconds is entered for the premeasurement delay and the 
SOP is saved, the value appears to be shifted to 30min 45 sec when the SOP is opened for review. 

It is only the display of some time-based parameters in SOP dialogues which is affected by the above bug, rather than the 
application of these parameters during an SOP-based measurement. For example, if 45 seconds is specified by a user for the pre- 
measurement delay, this will be correctly applied during an SOP measurement even though 30min 45 sec is displayed in the 
relevant SOP dialogue. In addition, the correct value for the pre-measurement delay (or any other time-based parameter) is stored 
in the measurement record and would be correctly printed on any reports referencing this value. Users can therefore validate that 
the correct time has been applied post-measurement. 

Firmware change for the Hydro 2000S and Hydro 2000G accessories 
The electronics and firmware used in the Hydro 2000S and Hydro 2000G accessories has been updated in order to improve the 
supportability of these systems in the long term. This has caused an update to the accessory calibration procedures, which are 
typically carried out during an Operational Qualification. To support the new calibration methods, the following software macros 
have been developed: 

• Hydro G Pump + Stir Cal.BAS 

• Hydro S Stirrer Cal.BAS 
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These macros are compatible with v5.30 and above of the Mastersizer 2000 software. For customers using versions prior to v5.30, 
any change to the calibration values will need to be carried out using a computer running v5.30 or above (e.g. using a service 
engineer’s laptop). 
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